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What is Web Weaver EZ? 

 
Web Weaver EZ is a free WYSIWYG (what you see is what you get) Web page editor for Windows.  Web 
Weaver EZ is a powerful editor that is ideal for beginners as well as advanced users of HTML. 
 
 
What is Web Weaver EZ PLUS? 
Web Weaver EZ PLUS is the shareware version of Web Weaver EZ.  It has more features than Web 
Weaver EZ, including 3 months of email technical support.  It costs $14.95 (US Dollars). 
 
Visit http://www.mcwebsoftware.com/wwez for more information including prices and order form. 
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Basic Tasks 

 

Setting Page Properties 
 
Uses: 
The Page Properties dialog box allows you to change the following properties of your Web page: 

• Web page title, 
• Text and background colors, 
• Background image(wallpaper), 

 
 
When the Page Properties button or menu item is selected, the following dialog box appears: 
 

 
 
 
WEB PAGE TITLE 
The document Title is used by the browser to identify the main title of the HTML document (Web page).  
Normally, the Web page title is displayed in the titlebar of the Web browser. 
 
 
 
WEB PAGE COLORS 
Select the ‘Colors’ tab and the following input boxes will appear: 
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If you know the RGB color codes, they can be entered into the text boxes using the keyboard.  Otherwise, 
click the Select color boxes and the color palette will appear.  You can then choose from a wide range of 
colors. 
 
BGCOLOR=###### is the Web page background color. 
TEXT=###### is the color of the normal Web page text. 
LINK=###### is the color of the hypertext (linked text) which hasn't been visited(clicked on) yet. 
ALINK=###### is the color of the hypertext when it is being clicked on(Active LINK). 
VLINK=###### is the color of the hypertext after it has been visited (clicked on). 
 
or select the color scheme from another Web page by clicking the 'Another Web Page' button. 
 
 
 
BACKGROUND IMAGE(WALLPAPER) 
Select the ‘Background Image’ tab and specify an image to be displayed as the background wallpaper of 
your Web page. 
 
You can browse for a background image file or type the filename into the text input box.  You can make the 
background wallpaper image into a static watermark by clicking on the watermark check box.  The 
background image will then remain stationary in your Web page while text and images will scroll over the 
image.  The code BGPROPERTIES=FIXED will fix the background image as a watermark.  This is an 
Internet Explorer extension only. 
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Inserting a HyperLink 
 
Uses: 
To create text that is linked to another Web page (URL), image, sound file, etc. 
 
 
When the HyperLink button or menu item is selected, the following dialog box appears: 
 

 
 
This box allows you to insert hypertext into your Web page that links to other Web pages (URLs), images, 
anchors (bookmarks), sounds or other files.  
 
In the box labeled Enter Hyperlink text type the text that you want to link to another Web page, etc.  When 
using a browser to view your Web page this text will be a different color (usually blue and underlined) than 
the rest of the text and the mousepointer will change to the shape of a hand when it is passed over the 
hypertext.  
 
In the box labeled Enter URL of Web page or file to link to type the URL that you want your hypertext to 
link to.  For example, it can be a Web page on your own site (dogs.html) or it can be a link to another Web 
site (http://www.yahoo.com). 
 
 
Example 
If you want to link the words “bird page” to a Web page named “bird.html”, then type: 
 

“bird page” into the ‘Enter Hyperlink text’ input box 
 
and type: 

“bird.html” into the ‘Enter URL of Web page or file to link to’ input box. 
 
After clicking the OK button the hyperlink will be displayed in your Web browser as shown below: 
 
 If you take a look at this bird page, then you’ll see exactly what this bird looks like. 
 
 
Clicking on the words 'bird page’ will load the Web page named bird.html. 
 
 
ADVANCED: 
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When you click on the Advanced tab on the Hyperlink dialog box the following screen appears: 
 

 
 
 
Check the Open link in new window checkbox if you wish the linked Web page to be displayed in a newly 
created Web browser window.  This allows the Web page you are linking from to stay open. 
 
If you wish to link your hypertext to an anchor (bookmark) in the same Web page or a different Web page, 
then you can select the Link to a Bookmark? checkbox and an input box will appear for you to type the 
name of the anchor (bookmark).  If the destination anchor that you are trying to link to is in the same 
document as the hypertext that links to it, you don't need to specify a URL name in the Enter URL of Web 
page or file to link to input box.  If the destination anchor is in a different Web page then you should specify 
the URL of that page in the Enter URL of Web page or file to link to input box. 
 
 
You can display text in the browser’s status bar when the mousepointer is moved over the hypertext.  You 
can also specify text (if any) to be displayed when the user moves the mousepointer away from the 
hypertext.  Specify this text in the two input boxes provided on this screen. 
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Inserting Images into your Web page 
 
Uses: 
To display an image in a Web page. 
 
 
When the Insert Image button or menu item is selected, the following dialog box appears: 
 

 
 
 
In the box labeled Enter filename of Inline Image enter the filename of the image.  You can use the browse 
button to find the image on your hard disk.  Also, you can use the image browser located on the lower half of 
the dialog box.  Browse through folders on your hard drive to view images to select the desired image. 
 
 
 
The following attributes are all optional: 
 
LINKING THE IMAGE TO A URL: 
Select the ‘Link to URL’ tab and the following input boxes will appear: 
 

 
 
 
If you wish to link the image to a Web page (URL), another image or other file, type the URL (address) or 
filename in the appropriate input box.  You can also use the browse button to look for the filenames to enter 
into this input box or browse Internet Explorer Favorites using the button. 
 
When using a Web browser to view your Web page the image will be displayed and will be outlined in blue if 
it is linked, rendering it clickable (clicking on the image will link you to the specified page/file.) 
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LAYOUT: 
Select the Layout tab and the following screen will appear: 
 

 
 
 
Specifying the image width and height 
The images WIDTH and HEIGHT can be specified in pixels in the input boxes provided. 
 
Specifying these values speeds up the display of your Web page when it is being loaded since the Web 
browser won't have to wait for the image to fully load to calculate its size.  Web Weaver will automatically 
insert the height and width properties if you browse for your image using the browse button or image 
browser. 
 
 
Specifying an image border 
The width of the border around the image can be specified in pixels (default is zero for normal images and 1 
for linked images). 
 
 
This controls the thickness of the border around the displayed image.  Setting BORDER=0 will show no 
border.  This may be confusing if the image is linked because the colored border that signifies a link will not 
be displayed. 
 
 
Specifying spacing between text and images 
To allow the user greater flexibility in laying out images and text use the Horizontal Space (HSPACE) and 
Vertical Space (VSPACE) attributes.  Specified in pixels (default value is zero). 
 
These attributes control the vertical space above/below and the horizontal space to the left and right of the 
image.  Specifying HSPACE=5 and VSPACE=5 will prevent neighboring text and images from coming within 
5 pixels of the image. 
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Creating an Email Link  -  MailTo 
 
Uses: 
To provide a link which allows the user to submit email to the specified email address. 
 
 
When this button or menu item is selected, the following dialog box appears: 
 

 
 
 
1. In the box labeled Email address: type your email address.  For example, type 
“info@mcwebsoftware.com” into the input box. 
 
2. In the box labeled Text that will appear as a link on the Web page type the text you wish to be 
displayed as a hyperlink on the Web page.  For example, type "Email Us" in the input box.  When the user 
clicks on the hyperlinked email address in their Web browser they will be able to write an email to you. 
 
3. Click OK and the HTML code will be inserted into your Web page. 
 
 
This is how the link will appear on the Web page: 
 
 Email Us 
 
Clicking on the link would result in the user emailing the address info@mcwebsoftware.com. 
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Background Sound 
 
Use: 
To play a sound when your Web page loads in a Web browser. The sound can play once or can repeat a 
specified number of times. Sounds can be either samples (.wav or .au format) or MIDI files (.mid format).  
Only Internet Explorer supports this tag. 
 
HTML Tag: 
 <BGSOUND SRC="music.wav" LOOP=Infinite> 
 
 
 
Inserting a Sound 
 
When this button or menu item is selected, the following dialog box appears: 
 

 
 
 
1. To specify a background sound type the name of the sound file (or browse for it) into the input box labeled 
Background sound filename. 
 
2. Specify how many times the sound file will repeat (play again) in the box labeled Loop the sound.  The 
range is from 'None' (play once) to an 'Infinite' loop which will repeat the sound file continuously. 
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Horizontal Line 
 
Uses: 
Inserts a horizontal line across the page.  The attributes allow the user to specify the thickness, 
width, alignment, and shading of the line. 
 
 
 

 
 
 
Attributes 
Line Thickness:  Allows you to set the thickness of the horizontal rule. 
 
Length of Line:  The default horizontal rule is always as wide as the page.  You can specify the desired 
length in pixels or percent of document width. 
 
Align:  Horizontal rules that are not the width of the page can be aligned next to the left margin, right 
margin, or centered on the page.  Possible values are left, right, or center. 
 
No Shading:  No shading allows you to specify a solid bar rather than the shaded default. 
 
Color:  The color of the line. 
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Text Box 
 
Uses: 
Creates a bordered or borderless box that contains text.  The text box can be dragged and 
dropped into any position on the Web page. 
 
 

 
 
 
Attributes 
 
Text:  The text that will appear inside the box on the Web page. 
 
Border Thickness:  The thickness (in pixels) of the border that surrounds the text box. 
 
Border Color:  The color of the border that surrounds the text box. 
 
Border Style:  The style of the border that surrounds the text box.  Different line styles such as solid, 
dashed, dotted, double can be specified. 
 
Text Color:  The color of the text inside the text box. 
 
Background Color:  The color of the background of the text box. 
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Inserting Anchors (Bookmarks) 
 
Uses: 
Used for establishing a destination anchor at a specific point in a Web page so that it may be linked to from 
the same or a different document (Web page).  This is useful for creating a long Web page with hyperlinks at 
the top of the page which link to different anchors in the same Web page. 
 
HTML Tag: 
 
 <A NAME="anchortext">some text</A> 
 
 
 
When this button or menu item is selected, the following dialog box appears: 
 

 
 
 
This dialog box helps you to insert an anchor in your Web page.  Think of it as placing a bookmark at a 
specific point in the Web page.  Different Web pages or hypertext can link to that specific bookmark (anchor) 
and the Web page will be displayed at that particular bookmark (anchor) when it is loaded in a browser.  You 
will not see the anchor when viewing the Web page.  It is like an invisible bookmark. 
 
To create an anchor: 
In the box labeled 'Anchor/Bookmark name', type the name of the anchor.  When creating the hypertext that 
will link to this anchor you will specify this anchor name to link to it.  See the section on Creating a 
Hyperlink in this manual to learn how to create a hyperlink to an anchor. 
 
(Optional) In the box labeled 'Enter the text that will be the Anchor/Bookmark’, type the text that will appear 
on the page at the location of the bookmark.  If you don’t specify text to be displayed on the Web page, the 
anchor will still exist in the location where you inserted it, and it can be linked to using hypertext. 
 
 
Example 
Suppose you want to create an anchor that is located halfway down a Web page.  When the user views the 
page in a Web browser, they can click a link at the top of the page that will automatically bring them to that 
anchor/bookmark halfway down the page.   
The text that you want to anchor is “Chapter 2: The Human Skeleton” and you want the anchor name to be 
“skeleton”. 
 
- In the box labeled 'Anchor/Bookmark name', type “skeleton”. 
 
- In the box labeled Enter the text that will be the Anchor/Bookmark, type “Chapter 2: The Human Skeleton”. 
 
Then click the OK button. 
 



Page 15 

You’ve created the anchor/bookmark, but you still need to create the link to that anchor.  This can be done 
by creating a hyperlink. 
 
 
Discussion of a hyperlink to an anchor 
The HTML hyperlink tag that will link to an anchor is equivalent to a regular hyperlink tag except it has the 
anchor name included (separated by a '#'' pound sign).  For example, linking to an anchor named 'ch1' from 
within the same Web page would look like: 
 
<A HREF="#ch1">Click here for Chapter 1</A> 
 
Linking to an anchor named 'ch1' from a different Web page named "toc.html" would look like: 
 
<A HREF="toc.html#ch1">Click here for Chapter 1</A> 
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Form Elements 
 
Uses: 
Create Web page forms using different Form elements such as text boxes, radio buttons, 
checkboxes, and more.   
 
 

 
 
 
Selecting these elements from the Side menu or the Insert menu will insert them into the Web page.  You 
can reposition them by dragging them with your mouse. 
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Special Effects 

 

Dropdown Menu 
 
Description: This JavaScript special effect creates a dropdown menu which links to different Web pages 
when the user selects a menu item and clicks on the button. 
 
Required files:  None 
Browser Compatibility: IE3, IE4, IE5, Netscape 3 and 4 
 
 
Use the following buttons to create your Dropdown menu: 
 
Add Menu item:  Use this button to add new Menu items to the list. 
 
Add Separator:  Use this button to add a separator line in the menu.  This line will not be linked to any Web 
page URL. 
 
Edit Menu item:  Use this button to edit existing Menu items. Simply select the menu item you wish to edit.  
Then click the ‘Edit Menu item…’ button and you will be allowed to edit the Menu item’s settings.  Separators 
cannot be edited (only removed). 
 
Move up:  Use this button to move a selected Menu item upward in the list. 
 
Move down: Use this button to move a selected Menu item downward in the list. 
 
Remove Menu item:  Use this button to remove Menu items.  Simply select the menu item you wish to 
remove.  Then click the ‘Remove Menu item’ button. 
 
 
To begin creating your Dropdown menu, click the Add Menu item… button. 
 
Provide the following properties for each menu item: 
 
Menu item text:  Enter the text for each Dropdown menu item.  Enter one menu item at a time. 
 
Link Menu item to this URL:  This is the URL of the Web page that will be displayed when the user selects 
the corresponding menu item and clicks on the menu’s 'Go to' button. 
 
 
These are additional settings for the Dropdown menu: 
 
Target Frame(Optional, only if using Frames:  If you want the Menu item linked Web page URLs to be 
displayed in a specific frame, specify the name of the frame here.  You cannot specify a different frame 
name for different menu items.  Only one frame name can be specified for all menu items. 
 
Display as a dropdown menu:  This will display the menu as a dropdown menu which shows only one 
menu item.  The user can click on the menu and it will expand to show all the menu items. 
 
or 
 
Display all menu items:  This will display the menu as an expanded menu showing all the menu items. 
 
 
When you have finished with all settings for all Pulldown Menu items, click the ‘OK’ button.  This particular 
special effect does not require any extra files and you can cut and paste it the HTML code into your HTML 
document using an HTML (Web page) editor of your choice. 
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Digital Clock 
 
Description: This special effect displays a working clock (in numeric format) on your Web page.  It also has 
the capability to display the date. 
 
Required files:  None 
Browser Compatibility: IE3, IE4, IE5, Netscape 2 through 4 
 
 
Begin by selecting from the following choices: 
 

• Show the Date only 
• Show the Time only 
• Show both the Date and Time 

 
 
Once you’ve made your selection, click the “Next >>” button to move on to the next screen. 
 
 
DATE FORMAT 
Select the date format you wish to display by clicking on one of the available formats from the list.  If you 
wish to also include the name of the day of the week (i.e., Monday, Tuesday, etc.) check the checkbox 
labeled Show the day of the week. 
 
Click the “Next >>” button to move to the next screen. 
 
 
TIME FORMAT 
The following Time Format properties can be set on this screen of the Digital Clock wizard: 
 
Show seconds:  Checking this box will display the number of seconds of the current time.  It is a dynamic 
clock so the clock will show the number of seconds incrementing. 
 
Show AM/PM:  Checking this box will display an “AM” or “PM” after the clock depending on the time of day. 
 
24 hour clock (military time):  Checking this box will display a military clock format.  For example 6 o’clock 
PM will not be displayed as “6:00”.  It will be displayed as “18:00”. 
 
Show Time before Date: The default setting is for the Date to be displayed before the Time (e.g., “November 
8, 2001   12:31PM”.  Checking this box will display the time before the date (e.g.  , “12:31 PM   November 8, 
2001” 
 
Click the “Next >>” button to move to the next screen. 
 
 
CLOCK PROPERTIES 
The following Clock properties can be set on this screen of the Digital Clock wizard: 
 
Background Color:  Click the color picker to specify the background color of the clock. 
 
Font:  Select a font name from the dropdown list or by clicking on the button labeled “more…” 
 
Font Size: Specify a font size by selecting from the dropdown list.  The font sizes are specified in points. 
 
Font Color:  Click the color picker to specify the color of the Clock text. 
 
Font style:  Select a font style from the dropdown list.  Available styles are Normal, Bold, Italic or Bold Italic. 
 
Padding:  Specify the padding (space or margins) to be placed around the clock text.   This number is 
specified in pixels. 
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When you have completed setting the special effect’s properties, click the 'Done' button. 
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Inline/Floating Frames 
 
Use: 
Using the Internet Explorer IFRAME tag, the author can create Web pages containing floating 
(inline/embedded) frames.  A floating frame can be thought of as a 'picture within a picture'.  They behave 
like an image in your Web page.  The floating frame can be placed anywhere on your Web page (like an 
image) and any HTML document (Web page) can be displayed inside the floating frame. 
 

 
 
The following properties are supported by the floating frame: 
 
Source URL - This is the filename or Web address (URL) of the Web page you wish to display in the 
floating frame. 
 
Width - Specify the width (in pixels or percentage of browser screen width) of the floating frame window. 
 
Height - Specify the height (in pixels or percentage of browser screen height) of the floating frame window. 
 
ALTernative text - Used to replace the floating frame in Web browsers that don't support floating frames.  
This is the text that you wish to appear if people are not able to see the floating frame. 
 
 
OPTIONAL PROPERTIES 
 
Horizontal Space - This controls the horizontal space to the left and right of the floating frame.  This 
prevents neighboring text from pressing up against the left and right sides of the frame.  Specified in pixels. 
 
Vertical Space - This controls the vertical space above and below the floating frame.  This prevents 
neighboring text from pressing up against the top and bottom of the frame.  Specified in pixels. 
 
Frame Border Size - This controls the thickness of the border around the floating frame.  Setting 
BORDER=0 will show no border. 
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Scroll bars - This specifies whether or not the floating frame has scroll bars to allow the user to scroll 
horizontally or vertically if the frame dimensions are smaller than the Web page that it displays. 
 
Align - To align neighboring text and images with the floating frame. 
 
Left/Right - These alignments provide a floating image type.  Aligning left will float the frame down and over 
into the left margin, and neighboring text will wrap around frame.  Align=right aligns the floating frame with 
the right margin and text wraps around the left hand side of the frame. 
 
 



Page 22 

Scrolling Marquee 
 
Use: 
The Marquee tag is used to create a scrolling text ticker on your Web page.  Text can scroll from right to left 
or from left to right.  Only Internet Explorer supports this tag.  For scrolling marquees that work on all 
browsers, download our product J-Perk from http://www.mcwebsoftware.com. 
 

 
 
To create a Scrolling Marquee: 
 
1. In the first input box marked Enter text you wish to scroll in your marquee, type the text you wish to 
scroll across the screen. 
 
The remaining attributes in the dialog box are ALL optional, but they provide a great deal of control over your 
scrolling text. 
 
2. The Behavior attribute specifies how the text should behave.  There are three possible values for 
behavior: SCROLL, SLIDE, and ALTERNATE.  Scroll (the default) causes the text to start at one side of the 
screen, scroll all the way across and completely off the screen, and then start again.  Slide causes the text 
to start completely off one side, scroll across the screen and stop as soon as the text touches the other side 
of the screen.  Alternate causes the text to bounce back and forth within the marquee. 
 
3. The Align attribute specifies that the text around the marquee should align with the TOP, MIDDLE or 
BOTTOM of the marquee. 
 
4. The Loop attribute specifies the number of times a marquee will loop when activated.  If the attribute 
Loop=1 or if Loop=Infinite is used it will loop indefinitely.  Loop can be set to any number. 
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5. The Height and Width attributes specify the height of the marquee, either in pixels or as a percentage of 
the screen height/width. 
 
6. The Vspace attribute specifies the top and bottom margins for outside of the marquee in pixels. 
 
7. The Hspace attribute specifies the left and right margins for outside of the marquee in pixels. 
 
8. ScrollAmount specifies the number of pixels between each successive draw of the marquee text. 
 
9. ScrollDelay specifies the number of milliseconds between each successive draw of the marquee text. 
 
10. Background color specifies the background color for the marquee either as an RGB code or as a 
primary color name (red, blue, etc.) 
 
 
 
This tag is only supported by Microsoft's Internet Explorer.  Netscape doesn't support it. 
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How to Upload your Web page to the Web  

 
 
OK, so you've created your Web page and it looks great, but now you want to put it on the Web for everyone 
to see!  Well, there are a few things you need in order to do this: 
 
1) You need an Internet Service provider (ISP) or online service (like AOL) that provides you with some Web 
disk space on their Web server. 
 
2) You may need an FTP client program (WS_FTP is a program that we recommend) for uploading 
(transferring files from your computer to the Web disk space on your ISP's Web server) the Web page and 
images to your Web disk space.  You probably don't need this if you are using AOL.  AOL has a built in 
program for transferring files. 
 
3) If you have an ISP other than AOL, then you will have to know the name of the ISP's FTP server(e.g., 
ftp.yourisp.com), possibly the name of the directory that contains your Web disk space (e.g.,/yourusername), 
your username and your password. 
 
AOL USERS 
 
Go to keyword MYPLACE and there are instructions there for uploading your Web page and images to your 
AOL Web disk space.   
 
 
OTHER ISP USERS 
 
Find out all the information from your ISP listed in step 3 above.  You will need to input it into the FTP client 
program in order for it to be able to log into your ISP's FTP server. 
 
When you are ready to upload your files, you must establish your connection to your ISP by dialing in as you 
would normally do when checking email or surfing the Web. 
 
Once you are logged in, run the FTP client program and connect to your ISP's FTP server (you should 
already have input all the information that the FTP client needed to login, see item #3 above).  If you 
successfully connect, you should see two window panes in the FTP client program.  One pane lists all the 
files on your computer's local hard disk, the other shows all the files in your Web disk space on your ISP's 
FTP server. 
 
Now transfer files from your computer to the FTP server by selecting files in the local window pane (showing 
your files) that you wish to upload.  Then click on the transfer button (sometimes has an arrow on it to show 
you which direction the files are being transferred).   
 
NOTE:  For Web pages (text documents) you should make sure you have selected the ASCII format for 
transferring(not BINARY format).   
For Images you must choose the BINARY format for transferring them.   
 
Select the correct formats for each file BEFORE transferring them to and from your FTP server. 
 
 
If everything goes smoothly, then you should be able to view your Web page on the Web.  If not, consult 
with your ISP and ask them if you are doing anything incorrectly. 
Your ISP should also know what the Web address (URL) is for your Web page.  The URL is the address you 
type into your browser to load a Web page, like http://www.mcwebsoftware.com 
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Helpful Web Sites 

 
Below is a list of helpful Web sites that provide manuals and tutorials on HTML authoring, advanced 

authoring, and sites which provide extras such as backgrounds, horizontal rules, etc. 
 
WebReference 
 http://www.webreference.com 
 
WebMonkey 
 http://www.webmonkey.com 
 
HTML Goodies 
 http://www.htmlgoodies.com 
 
HTML Quick Reference Guide: 
 http://www.ucc.ie/~pflynn/books/htmlcard.html 
 
The WWW Consortium (straight from the horse's mouth): 
 http://www.w3.org/ 
 
HTML Cheat Sheet: 
 http://hotwired.lycos.com/webmonkey/reference/html_cheatsheet/ 
 
HTML Color Codes: 
 http://hotwired.lycos.com/webmonkey/reference/color_codes/ 
 
HTML Special Characters Reference: 
 http://hotwired.lycos.com/webmonkey/reference/special_characters/ 
 
Creating HTML Frames: 
 http://hotwired.lycos.com/webmonkey/authoring/frames/index.html 
 
Creating HTML Tables: 
 http://hotwired.lycos.com/webmonkey/authoring/tables/index.html 
 
Cascading Stylesheets (CSS): 
 http://hotwired.lycos.com/webmonkey/authoring/stylesheets/index.html 
 
DHTML Reference: 
 http://msdn.microsoft.com/library/default.asp?url=/workshop/author/dhtml/reference/dhtmlrefs.asp 
 
XML:�
 http://hotwired.lycos.com/webmonkey/authoring/xml/index.html�

 
 
 


